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Preface

About Farm Works Software

Farm Works Software is a complete line of management tools for the grower as
well as the agricultural professional.  The grower level packages (Farm Trac+,
Farm Fund$, Farm Site, Farm Stock, Farm Trac Mate, Farm Site Mate and Guide
Mate) offer the farmer an integrated approach to farm management.  Site Pro
takes this integration to the next level.  Site Pro allows the agricultural professional
to exchange information with his clients, and provides
a powerful tool in analyzing the wealth of information that can be collected with
today’s precision farming technology.  Using devices equipped with a Global Po-
sitioning System (GPS), analysts can use Site Pro to map and query such infor-
mation as fertility, soil type, elevation, harvest moisture, and production.  In addi-
tion to the layering and mapping features, Site Pro has an integrated field history
and chemical application record system built into the program.

Layout of this Manual

This manual is designed to give you explanations of how your Site Pro program
works and what you need to do to use the program successfully. This manual is not
designed to give you step by step instructions on how to complete certain tasks.
Refer to the tutorials and  help files for detailed descriptions of how to enter infor-
mation as well as a listing of commonly asked questions. This manual is designed
so that you can sit down and read it in an evening and have a good idea of how
Site Pro works and what you will need to do to get started.
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Overview of Site Pro

Site Pro has been developed with the special needs of the agricultural profes-
sional in mind.  Data collected from yield monitors, soil tests, and field scouting
can all be recorded on an unlimited number of layers for each of your clients. This
information is organized by client and category to provide a quick and simple means
of accessing any layer of data.

Once these layers are generated, correlations and trends can be identified using
the layering and analysis tools.  For example, to analyze the variability of yield due
to soil type, Site Pro can give you an average yield for each soil type in the field.
The effect of other factors such as weeds, elevation, and soil fertility can also be
mapped and analyzed with Site Pro.  Problem areas can be quickly identified
using the Show Me option to limit the points or areas displayed to those with
certain characteristics, such as corn yields less than 75 bushels per acre.

Site Pro also helps you and your clients comply with federal chemical record keep-
ing requirements. Using the fields on the map as a type of filing system, product
applications can be recorded and EPA reports generated with just a few clicks of
the mouse.

Along with application records, scouting and other important information can be
recorded on each field using notations.   Each notation can be categorized and
later queried to help keep track of important observations that can help you make
recommendations in the future.

Farm Site Pro is unique in that it works with nearly any type of yield  data. Farm
Works maintains a list of all such types of data that can be used with Site Pro. If the
type of data you are working with is not on this list, contact Farm Works and a
Farm Works representative will contact the precision equipment company and try
to work with their data.

Some other features:

• Reads industry standard ArcView Shape Files.

• Gives you an unlimited number of layers. Layers can represent anything from
yield maps to soil types to field tiling.
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• Reads ASCII soil test data from most soil labs.  Soil Test data can be matched
to previously mapped soil sample locations.

• Exports data in many standard formats including ArcView Shape Files.

Installing Farm Site Pro
Following is a list of hardware and software required to run Farm Site Pro:

• Personal Computer with Pentium processor or higher.

• 64 megabytes or more of RAM.

• Hard Disk with 10 megabytes of free space.

• Microsoft ® Windows ™ 95 (or higher) installed.

There are two important notes before you start installing your software:

• The files on all Farm Works installation CDs and diskettes are compressed,
so you cannot install Farm Works by copying the files.

• Choosing Cancel during installation halts the process and Farm Works will
not be properly installed on your computer.

Installation Procedures

1. Insert the Farm Works CD into the appropriate CD ROM drive. Windows™
will automatically begin the installation process for you.  If the installer does
not start itself, choose Run from the Start menu and then type D:\Setup in
the box under the command line (where “D” is your CD drive).

2. Select the “Install Farm Mate Programs” from the installation screen, and
then select the programs that you wish to install. Some programs will require
a code in order to be installed. These codes may be found on cards that are
packaged with each program.

3. Follow the instructions on the screen to complete the installation process.

4. After the program has been successfully installed, a message will appear
that says, “Farm Works successfully installed.”  You may now close the instal-
lation window.
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5. Exit Windows™ and reboot the computer.

Registering Your Software

To obtain full use of your copy of Site Pro and to receive information on future
upgrades to the program, you must register it under the owner’s name with a num-
ber provided by Farm Works. Registration takes just a few moments to complete.

To use the on-line registration form, go to www.farmworks.com/register and select
the programs you have installed.  You will need to enter your Installation ID or Ma-
chine ID that is displayed on your screen, along with your product code numbers
and click Submit.  Fill in your contact information and the place of purchase on the
next page and click Submit Registration.  If you have completed the information
correctly, you will receive an e-mail containing your registration numbers, typically,
within an hour.

To register your software by fax or mail, you will need to complete and print the
registration form from your registration screen.

1. Type your name or company name in the Licensee Name text box.

2. Choose OK and the Farm Works Registration box appears.

3. To print the registration form, choose the Go To Registration Form button.
The Registration Information dialog box will appear.

4. Fill in your name, mailing address, who you purchased the software from, any
comments, your phone and FAX numbers.

5. Choose Print to make a copy of this information.

Mail or fax your completed form to:

Farm Works Software
PO Box 250
Hamilton, IN 46742-0250
FAX (260) 488-3737
Phone 1-800-225-2848
E-mail: farmwork@farmworks.com
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To receive your registration number directly by phone, be sure to have the printed
form in front of you so that you can answer all information correctly. It is a good idea
to be at your computer, with the software Registration dialog box on your screen,
when you call. You do not have to mail the registration form if you get your number
over the telephone.
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Getting Around in
Farm Works

Menus

Menus are lists of things from which you can do one of four things:

• Do something immediately. An example would be saving any changes you
have made to your map. The computer will know where to save the changes.

• Ask for more information, then do something. An example would be
making a backup of your project. The computer needs to know what you want
to call the backup and whether to put it on a floppy disk or on your hard disk,
so it will ask for that information before making the backup.

• Change a setting in the computer. An example would be selecting the line
drawing tool. When you select this kind of item from a menu, a check mark will
appear next to it to indicate that it has been selected.

• Display another menu. Most menu items at the top of the main map window
are of this type. These menu items help to organize choices into logical
groups, so that individual actions are easier to find and use. These items
usually have a small arrow on the right to indicate that they activate another
menu.

Sometimes menu items are gray and they cannot be selected. For example, if you
do not have a printer, the print option will be gray.
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Menu Bars

Menu Bars, when available, are always at the top of a window.
Most items on a menu bar display another menu. There are a

few exceptions, such as the date on the main map window; click-
ing it allows you to change the working date for transactions.

Right-click Menus

Another kind of menu you will find in Farm Works is a right-
click menu, so called because it will appear when you press
the right mouse button. Choices on a right-click menu are
associated with the currently selected item. For example,
the pointer and text tools have right-click menus available,
as do the icons used to represent your equipment, people,
and animals. Depending on what is selected when you right-
click, the menu will be different. This illustration shows the
menu when you right-click on a field; if a tractor icon is se-
lected, fuel will be an option.

Button Bars

A button bar is a row of buttons across the top of a window. Each button is a
shortcut to a menu item, and pressing the button has the same effect as selecting
the menu item. When a button
changes a setting in the com-
puter, it remains highlighted
while selected, and a check mark appears by the menu item it is associated with.
With Farm Works you can change the group of buttons displayed by selecting the
category, such as Mapping Tools, from the list.
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Dialog Boxes

When the computer wants information or an answer to a question, it will display a
dialog box. A dialog box is a window that contains various means of inputting
data.

Buttons

A button, when pressed, acts immediately. For example, the Print
button prints the report.

Edit Boxes

An edit box is a place in which to type information. There
are three basic types of edit boxes, designed for dates,
numbers, or text. A date edit box allows you to enter the
date several ways. For example, 7/25/03, 7-25-03, or
72503. In addition, a date edit box allows the use of the plus or minus keys to add
a day or subtract a day from the date it contains.

Check Boxes

A check box is a small, square button next to text and is
used for single options that are either on or off. Click on
the square box to turn it on or off.

Radio Buttons

Radio buttons always come in sets and work in groups. They are
used when there are two or three choices that cannot be on at the
same time. When you press one radio button in a group, it turns
off all the other radio buttons.
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Lists

A list or list box contains a list of items. To select more than one item at a time, try
holding down the Shift key to select a group of items or the Ctrl key to select
several individual items.

Paired Lists

A paired list is used to se-
lect a group of items. One
list has all available choices,
the other the selected
choices. Move an item from
one list to the other by select-
ing the item you want to
move and clicking the ap-
propriate arrow button, or by
double clicking on the item
to be moved.

Drop-down Lists

A drop-down list is used where a
list would take up too much space.
The current selection is displayed,
and pressing the arrow button pops
up a list of other possible selections.
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<Add/Edit>

In Farm Works, many drop-down lists contain an <Add/Edit> item. Selecting this
item will display a dialog box that allows you to enter or change information about
the choices in that list.

<New>

Another choice is the <New> item. Selecting
this signals that you want to create a new entry,
as opposed to editing an existing entry. As pic-
tured, this box is often paired with an edit box
where you can enter the name for the new entry.

Combo Boxes

A combo box is similar to a drop-down list, but allows you to add items not already
in the list.

Calendar Button  

The calendar button is available any time
that a data can be entered or changed.  Sim-
ply click on the button and a calendar will
appear.  Use the arrow buttons at the top of
the calendar to scroll forward or backward
through the months and left click on the de-
sired date.  You can also left click on the
month or year at the top of the window   se-
lect the desired month and year.
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Using the CD Tutorial
and Demos for Help

The installation CD contains Tutorials and Demos to help the user learn the Farm
Works programs. This should be one of the first places to look for help on ques-
tions and problems. The tutorials contain step-by-step instructions on how to use
the Farm Works programs, while the demos present a general overview of pro-
grams features. Viewing the CD will give the user information about all of Farm
Works products.

The Tutorial/Demo is located on the installation CD ROM. The best way to use the
Tutorials/Demos is to run the Farm Works program at the same time you are run-
ning the tutorial and switch between the programs.

Running the Tutorials and Demos
To run the Tutorials or Demos
insert your Farm Works CD into
the appropriate CD ROM drive.
Windows will automatically dis-
play the CD start screen. Select
the Tutorials or the Program
Demos button.
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Tutorials

At the next screen, select the tutorial you wish to view from the
list.  Click on the Plus button beside a Program to view its con-
tents.  Individual topics may be viewed by opening a category.

The guidance buttons (Reverse, Stop/Go,
Pause/Resume, or Fast Forward) on the
bottom right side of the screen help the user
move around in the tutorial.

• Back—Goes back one screen in the tutorial
• Stop/Go—Starts and Stops the tutorial
• Pause/Resume—Pauses and Resumes the tutorial
• Fast Forward—Advances the tutorial

Switching between Programs

To switch between Farm Works and the Tutorials/Demos click
on the appropriate program button in the Windows status bar.

An alternate way to switch between the
programs can be achieved by holding
down the <Alt> key and pressing the
<Tab> key as many times as necessary
to select the program you wish to view.

Demos

At the Tutorials and Demos screen select the demo you wish to view.

The guidance buttons on the bottom right side of the screen help the user move
around in the demo.
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This manual is designed to give an overview of how Site Pro works. More detailed
instructions on how to use specific areas of the program will be included in the help
system. The help files will always contain up-to-date, detailed instructions on how
to enter information into Site Pro.

The easiest way to access the help files is to select the Help Index option on the
menu at the top of the Farm Works screen. You can also select How to use Help
to get more information on using the help system.

In addition to the help menu, you will see a Help button in most dialog boxes. By
clicking on this button you can go to a short explanation of how to enter information.

At the end of each help topic, notice that the words
Commonly Asked Questions and Detailed Expla-
nation are colored and underlined. Any text within the
help file that is a different color can be clicked to get a
short “Pop-up” explanation or “jump” to another help

topic.

For example, if you clicked on Commonly Asked Questions you would go to a
list of commonly asked questions for your topic. You could then click on any of the
listed questions to see the answer.

Most of the topics that you access with the Help button will give a general overview
of how the dialog box works. If you click on Detailed Explanation at the end of the
help topic, you will get an in-depth explanation that includes examples and typical

Using Help Files
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uses for that dialog box. Additionally, this detailed help will include a picture of the
dialog box that you were working in.

As you move the cursor over the dialog box, notice that it turns into a hand. By
positioning the hand over any part of the dialog box, you can click and get an
explanation of that part of the box.

Inside the Farm Works on-line help system, there are several buttons at the top of
the screen. Following is a brief explanation of each of the buttons:

• Contents:  Clicking on this button will display the Contents page, where you
can browse the available help topics.

• Search:  Opens a dialog box where you can enter any word or phrase and find
help topics that apply.

• Back:  Returns to the previously displayed help topic.

• Arrows:  On-line help topics are grouped by area; for example, all Layer
Management help topics are grouped together. These buttons move between
the help topics within the current area.

• Q & A:  Displays a list of commonly asked questions and their answers.

• Close:  Exits the help system and returns you to Farm Works.

• WINHELP:  Displays general information about Microsoft Windows helps.

• Print:  Prints the currently displayed help topic.
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Overview
At the heart of Site Pro is its ability to organize information for each client into
layers.  These layers can represent various attributes about each location on the
farm including soil type, fertility, elevation, yield, weed infestations, or just about
anything else that can be measured and mapped.  Layers can also be created to
map the area’s roads, waterways, and other landmarks to help locate and identify
a client’s field just by looking at the map.

Clients
A client represents each of the growers that you work with, and is represented by
the file cabinet within the Layer Management window.  Every layer in Site Pro is
associated with a client. Each client that is added to Site Pro will have a Main
Layer.  The Main Layer will contain all the fields for that client, and is the source for
boundary information about each field.  This layer is also the primary means of
accessing field history and chemical application records.

There will be one client that is slightly different from the rest of those you will create.
It is labeled as Common, and it is used to organize information that does not
belong to a particular client, such as road or waterway layers.  The Common client
is also unique in that it will not have a Main Layer.

Clients and Layers
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Category
A category is used within a client's directory to help organize layer data.  It is repre-
sented by a file folder.  Category examples include Yield Data, Soil Samples, Scout-
ing Data, etc.

Layers
Each layer in Site Pro is represented by a sheet of paper and acts like a sheet of
transparent paper that contains just about any information that can be mapped.
The layers that you create may contain georeferenced data that can represent
attributes about a single point or an entire area.  The type of data that you wish
each layer to contain is customized by you to meet whatever needs you and your
clients may have. Since these layers are like transparencies, the information from
one layer can overlay information on another, thus allowing correlations and rela-
tionships to be studied.

Selecting Layers to Display
The Layer Management dialog box is where you will select which layers to dis-
play and in what order.  The Layer
Management window is found by
selecting Active Layer-More Lay-
ers within Site Pro or by selecting
the Layer Management button from
the layers tab at the left of the main
Site Pro screen.  The two main fea-
tures of this box are two lists-Avail-
able Layers and Displayed Lay-
ers.

The Availalbe Layers box con-
tains all layers that have been cre-



19

ated and resembles Windows Explorer, in that there is a hierarchy of client, cat-
egory, and layer.  To view items under a client or category simply double click on
that item or click on the + that precedes it.

The second box in the Layer Management window is the  Displayed Layers box
and lists those layers to be displayed and their order.  Layers closer to the top of
this list are painted over those layers closer to the bottom of the list. This order can
greatly affect the results you achieve when overlaying multiple layers on the screen.
The very topmost layer is special and is referred to as the Active Layer.  This is
the layer that the drawing tools will be editing and whose data can be added to,
deleted, or modified.

Layers can be moved to and from the list of displayed layers by dragging them with
the mouse from one list to the other, or by using one of the buttons that separate the
two lists. Layers that are being displayed will have a blue backgound in the list of
available layers. Once in the displayed list, layers can be ordered by dragging
them with the mouse or by using the appropriate button to the right of the list.

Creating and Editing Clients

 New clients may be created by selecting
New-Client from the File menu or by right
clicking on an existing client, category or
layer and select New-Client.

Selecting Delete from the File menu will
delete the selected Client and its contents.

Selecting Properties from the File menu
will allow you to edit the name of selected
client.

These options may also be accessed by right-clicking on a client adn selecting the
desired item on from the right-click menu.
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Creating and Editing Categories
To create a new category:

1. Select New-Category from the File menu within the Layer Management
window

or

Right click on a client, category or layer and selecting New-Category from
the pop-up menu that appears.  The Layer Category window will appear.

2. Type the name of the new category in the Description box.

3. Select the Add button.  The new category will be added tothe Layer
Category list on the left.

4. Select Done when the new
category(s) has been added.

NOTE:  New categories will not appear
in the Available Layers window until a
layer has been assigned to that category.

To edit the name of an existing category:

1. Highlight the category and select
Properties from the Layer
Management File menu

 or

Right click on the category and select Properties.

The Layer Category screen will appear.

2. Highlight the category in the Layer Category window.

3. Make the desired changes to the name in the Description window and



21

select Rename.

4. Select Done when finished.

Existing categories may be deleted by highlighting the unwanted category and
selecting Delete from the File menu within Layer Management or by right clicking
on the unwanted category and selecting Delete.  Deleting a category will delete all
layers within the selected category as well.

Creating and Editing Layers
A new layer may be created by first selecting the client or category to which you
wish to add the layer, and then choosing New · Layer from the File menu in the
Layer Management dialog box or by right clicking on an existing client, category
or layer and selecting New-Layer from the pop-up menu.

Each layer may be assigned to a category.  Layers will generally be grouped in
one of two ways.  The first method is by the type of information in each layer.  An
example of this type of
grouping would be to
have the following cat-
egories:  Soil Tests,
Yields, and Seed Vari-
ety.  The second
method is to group lay-
ers based on the farm
for which the informa-
tion is associated.  An
example of this type of
grouping would be to
have the following cat-
egories:  McCool
Farm, Home Farm, and South Farm.  Layers do not have to be assigned a cat-
egory and may be assigned to a different category at any time.
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There are three types of layers that may be created: Point, Area, and Lines Only.

• Point:  Represents data collected for a particular point, such as yield monitor
data or soil samples.

• Area:  Used when attributes apply for an entire area of a field, such as soil
type or seed variety planted.

• Lines Only:  Information that is only expressed as lines drawn on the screen,
such as roads or waterway maps.

Once the type of layer to be created has been decided, it is necessary to deter-
mine the data fields that the layer is to record.  If the layer is Lines Only, you will not
have the option to set up a georeferenced database for that layer.  The rows in the
table represent each data item you wish to record on this layer. Each item in this
database must be given a description and assigned one of the following data
types:

• Choice:  items that can be enumerated in a list, such as seed variety, soil
type, or weed species.

• Date:  items such as planting and harvesting dates.

• Field:  used to associate a record with a particular field that has been created
on the Main Layer.

• Number:  items that represent any type of numeric information, such as yield,
pH, or elevation.

• Pattern:  allows a color and/or pattern to be assigned for that data item.

• Size:  a special form of numeric data that is automatically defaulted to the
acreage of the defined area.

• Text:  used to record free form text about the point or area defined.

• Yes/No:  used for field marker data for most yield monitors, Yes represents
where the marker was on and No represents where it was off.
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Layers that contain information collected from yield monitors must have specific
data items, and should be created when you are ready to import the data from the
PC card or text file.

Once created, the layer’s name, data items, and type can be changed by selecting
Properties from either the File or right-click menus.

Layer Management Organization
Selecting Layer Tree Layout from the File menu within Layer Management will
allow you to choose how your clients, categories and layers are sorted.

For each box that is checked within Layer Tree Layout, a subcategory will be
created beneath the client.  The order of the items beneath Layer Tree Layout
determines the order of the subcategories.  To change the order of the options
highlight the item to be moved and left click on the appropriate arrow to the imme-
diate right of the Layer Tree Layout window.  Each time an arrow is selected, the
item will be moved up/down one place.

Layer Description will allow you to select how layer names will be displayed.
Each box that is checked beneath Layer Description will allow that item to be
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displayed within the name of the layer on the Layers tab.  The order information is
displayed in a layer name is determined by the Layer Description window as
well.  To change the order of the options highlight the item to be moved and left
click on the appropriate arrow to the immediate right of the Layer Description
window.  Each time an arrow is selected, the item will be moved up/down one
place.

The Sample Layout area allows you to pre-
view the selected changes before they are ac-
cepted.

The information for the Layer Tree Layout is
pulled from the Layer Properties of a layer
(right click on a layer name and go to proper-
ties).  If any information is selected for use in
the Layer Tree Layout, but is missing from
Layer Properties it will display as ‘Undefined
commodity, field, etc.’.

Memorized Display Configurations
The process of selecting and ordering the layers to display will play a large role in
determining the results you achieve on the screen.  Site Pro automates this pro-
cess somewhat through the use of saved display configurations.  The Startup con-
figuration is a set of layers that you use often and would like to have displayed
when the program starts.  To set up or change this configuration, organize the
layers you wish to use in the Displayed Layers list in the Layer Management dialog
box, and then choose Save As Startup from the File menu.

When working with a particular client, it may be convenient to select a number of
layers as a starting point.  This client specific configuration may be saved as the
default for the client.  To save this set of layers organize them in the Displayed
Layers list, right-click on the client, and select Save As Default for Client.  This
configuration may be recalled by right-clicking on the client and selecting Use
Default for Client.
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Copying and Archiving Layers
A copy of an existing layer can be made by right-clicking on
the layer and selecting Copy.  Site Pro now knows which
layer to copy and is waiting for you to choose where the new
layer is to be placed.  Right-click on the client or category
you wish to create the new layer in, and select Paste.  All the
information on the original layer will be copied to the new
layer, with one exception:  if one of the attributes for the layer
is Field and you are pasting the layer under a different client,
the Field information will be removed because the two cli-
ents have different fields.

Layers may also be archived for use by the client, or as a backup in case of com-
puter failure.  To create a layer archive, right-click on the layer and select Archive
Layer.  This will create a compressed  file with all the information on that layer.
This archive can be retrieved by right-clicking on a client or category and selecting
Import Archived Layer.  Your client can also use this archive to create a layer in
his Farm Site project.

Importing Client Projects
For those clients who already have Farm Site, you
may wish to import the layers that they have already
created.  These layers may be imported individually
as an archived layer, or all together by selecting Im-
port Client Project on the right-click menu in the
Available Layers list.  The client can create the file to
be imported by making a backup of his Farm Site
project.

Creating Client Projects
Once you have created layers of information for your client, you can provide them
with a starting point for their own Farm Site project.  To create a client project, right-
click on the desired client and select Create Client Project.  After selecting the
layers you wish to export to the client, a compressed file will be created that can be
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used as a project backup in Farm Site.

Current Layers Window
In order to help you work with several layers at one time,
Site Pro provides a list of layers that are being displayed
to the left of the mapping screen.  This list is known as
the Layers Window.  The top layer is displayed in a
different color to signify that it is the Active Layer, and is
the only one that the mapping tools will affect.  Another
layer may be made the Active Layer by double-clicking
on it or dragging it to the top of the list.  The order of
layers in this list can be changed by dragging the se-
lected layer to a new position or using the buttons at the
bottom of the Layers Window. This list also provides a
quick means of accessing the various display options
for each layer.  These options can be selected through
the right-click menu on each layer.



27



28



29

Mapping Tools
With the Farm Works mapping tools, you can draw lines, squares, circles, or any
other shape representing your fields, barns, woods, and other landmarks and struc-
tures. You will use these tools to their fullest if you also understand how to operate
the Zoom and View tools, important positioning aids that help you view your farm
on the screen.

The more that you practice and play with these tools, the easier they will be to use
when you start drawing your actual maps.

Use this chapter to understand the tools available and their use. For step-by-step
instructions on the use of a particular tool, see the tutorials or help system.

Pointer Tool

The Pointer tool is used to select lines and objects for editing. It is also used to
work with objects that have been drawn and defined.

Selecting Lines and/or Objects

A line or object must be selected to delete it, move it, or to use the right-click menu.
A single line or object can be selected by clicking on it with the Pointer tool.

The pointer tool may be set to one of four different uses through the pointer tool
drop-down list.  The standard Rectangle option will allow you to select a square
area.  The Circle option will allow you to select a circular area.  The Polygon option
will allow you to left click around an irregular object to select everything inside that
area.  This tool works much like the multi-line tool.  To select multiple lines or ob-
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jects using the Rectangle option, click just outside the
group and drag the “rubber band” to the opposite cor-
ner so that all items within the group are selected.  Lines
that are selected will blink. Objects that are selected
will have a gray crosshatch pattern.  Alternately, hold
down the Shift or Ctrl key on your keyboard and click
on each item.  Clicking on the Invert Selection option
will select everything outside the highlighted area.

Deleting Lines and/or Objects

Once the lines and/or objects have been selected, use the Delete key on the key-
board or the Delete option on the right-click menu to erase them. If an object is
chosen for deletion, the object itself, lines that are not part of an object, or both may
be deleted.

Moving Lines and/or Objects

To move lines and/or objects, select the lines or objects, hold down the mouse
button until the cursor turns into a hand, then continue to hold down the mouse
button while you move the object to the desired position.

Displaying a Field’s Acreage

When a field has been selected with the Pointer tool, its size will be displayed on
the bar at the bottom of the screen.

Right-Click Menu

The right-click menu offers various options that can be performed on the object
such as merging, deleting, printing notations, etc. Use the Pointer tool and right-
click on an object to display the options available.
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Measure

The Measure tool is used to measure the length of lines.  After selecting this
tool, left click at the starting point of the line and left click at each point a direction
change is needed.  The total length of the line will be displayed at the bottom
right corner of the screen.  Right click to remove the measure line from the
screen.

Edit Points

Edit Points is used to stretch lines or to add end points to the middle of lines to
create bends and curves. This is very useful when the calculated acres differ from
the actual acres. By moving a corner in or out, the size and shape of objects can be
changed.

If an object is selected with the Edit Points tool, its area will be displayed in the
bar at the bottom of the screen. As points are moved and/or deleted, the area of
the object changes, and the new area will be displayed.

Freehand (Pencil)

The Freehand tool works just like a pencil with the added feature that you can
straighten the lines. To use this tool just hold the left mouse button down as you
trace objects on the screen.  Individual lines connected end to end are generated
to create the final outline.  The relative smoothness of the shape drawn can be
adjusted once the mouse button is released.  The more smooth the curve the fewer
the number of lines that are required to be generated.

Although this is a versatile tool, use it sparingly, as this tool creates lots of small
lines that can slow the speed of loading and displaying maps.

Line Tool

The Line tool is used to draw a single line on the screen.
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Multi-Line Tool

The Multi-Line tool is used for drawing irregular field boundaries and is the most
commonly used tool for tracing field boundaries and other objects.  To use this tool,
left click at the start of the line and continue to click at each bend in the line.  The
right mouse button is used to end the operation.

Rectangle Tool

The Rectangle tool is used by dragging in any direction from where you originally
clicked. This tool is very useful when drawing structures.

Circle Tool

Circles are represented as collections of small lines which
can be moved or deleted as necessary to create ovals
or semicircles. The Circle tool is ideal for drawing ponds
and center-pivot irrigation systems. Circles may be drawn by their diameter or
radius by making the appropriate choice using the circle drop-down button.

Dual Line Tool

The Dual Line tool is used for drawing a pair of lines that are a set distance apart.
It is similar in operation to the Multi-Line tool, but allows you to set the distance
between the lines once the right mouse button is clicked.

Contour Drawing

The Dual Line tool in conjunction with the End Point tool can be used to draw
fields for contour farming. For detailed instructions, refer to Commonly Asked Ques-
tions in the helps.

Corner Tool

The Corner tool works with two lines, extending or shortening them as necessary
to form a clean corner. This is useful to ensure that two lines intersect and that there
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are no gaps in the border of an object.

Tee Tool

The Tee tool extends or trims one line to a point that would intersect with a second
line. This is different from the Corner tool in that it only changes one of the lines
and does not ensure that the two intersect.

Define Objects

The Define Object tool is used to identify areas on the screen as fields, struc-
tures, or landmarks.

A field is any area that contains a growing crop and where farming actions take
place. Structures include buildings and other objects such as barns, grain bins,
and houses. A landmark is anything that is neither a field nor a structure such as
woods, ponds, and non-tillable ground.

Note: A woods can be a landmark or a field. If you are cutting the timber and you
want to keep records on this, the woods should be classified as a field, otherwise
use the landmark category.

To define an object as a field, structure or landmark, select the Define Object Tool
and click inside the object.

Caution: The most common problem when defining objects is a gap where inter-
sections occur (a small gap can be impossible to see, even when fully zoomed).
If you think you have this problem, or if the computer beeps and refuses to de-
fine the object, use the Corner tool to rebuild all intersections for the object.

When an object is defined the Object Properties box will appear.  The Object
Properties box is broken into four different sections that are represented by tabs.
The sections are:
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General:  The General tab is where you’ll enter a Description for the object and
select a Category (Field, Structure or Landmark) and enter the size of the object.
When choosing a name for an object, you may wish to use names that list similar
fields, structures, and landmarks together. For example, if you are renting from
someone named Smith, enter descriptions such as Smith1, Smith2, etc. for those
fields. The fields will be listed together, which makes them easier to select when
printing reports.  Normally, you will not want to enter the legal description for the

field.  If you delete an object, you can restore the information that was saved with it.
After the field is redrawn, use the Define Object tool to redefine it. Choose the
deleted field name from the drop-down list of objects.

Field:  The Field tab is used to enter owner/landlord information as well as FSA
information and a legal description.  When you first define a rented field, you may
create a list of landlords by selecting <Add/Edit> from the Name drop-down list.
Additionally the FSA and Legal Description areas can be used to enter addi-
tional information for each field.  This information will be used for creating reports
for the FSA, crop insurers and others.

Pattern:  The Pattern area is used to select the colors and patterns that will ap-
pear on objects on the map. These colors and patterns can be used on fields to
indicate the type of crop being grown as well as the stage of the field. This allows
you to display your farm and know the status of each field based on its color and
pattern.  Pattern Templates can be used to assign a name to any selected color
and pattern.  By assigning a name, you will be able to recall the same colors and
patterns for other fields by selecting the template name from the drop-down list.
The template names will also be used as a legend when printing maps.  Select
<Add/Edit> from the Template drop-down list to add names to the list of templates.

Photo:  The Photo area is used to assign an image to the object being defined.
This can be useful if you are defining a bin, barn or other structure since keeping
pictures of structures can be useful for insurance and other purposes.  Images can
be a picture from a digital camera or a scanned image of a normal picture.  Im-
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ages need to be in either a .jpg, .tif, .bmp or .pcx format.  Note that this area is not
normally used for displaying aerial images that will be used for mapping.  See the
chapter in this manual titled Using Images for more information on using aerial
imagery.

Text Tool

The Text tool is used to add text anywhere on your map. Select the location on
your map where the text is to appear and enter the text. To change the type or size
of the font, select the Text tool and right-click on the text.

Once a field has been drawn and defined, a label can be added that will display
the name of the field on the map. Using the Pointer tool or the Text tool, right-click
on the object and select the Add Label option from the drop-down menu.

To remove the label, right-click on the object with the Pointer tool or Text tool and
select Remove Label.

Endpoint Tool

The Endpoint tool is used to select the endpoint of an existing line as the begin-
ning or ending point when using other tools.

Midpoint Tool

The Midpoint tool is used to select the midpoint of an existing line as the begin-
ning or ending point when using other tools.

Grid Snap

The Grid Snap feature allows precise positioning of objects and lines on the drawing
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screen. The grid will display on the map as points that are evenly spaced across
the drawing screen based on the grid size that was entered. The Grid Snap tool
cannot be used alone, it must be used in conjunction with other tools.

To set the size of the grid choose Grid from the View menu or right-click the Grid
Snap button on the tool bar.

Horizontal Tool

The Horizontal tool is used to force the drawing of lines or the movement of ob-
jects in a horizontal (left to right) direction.

Vertical Tool

The Vertical tool is used to force the drawing of lines or the movement of objects in
a vertical (up and down) direction.

Pan Tool

The Pan tool allows you to move the display of your map with greater detail than
the slide bars along the bottom and right side of the screen.  After selecting this
tool, left click and hold down on your map.  Move you map to the designated area
on the screen and release the mouse button.  The Map will remain in the selected
location.
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Other Options

Merging Objects

The Merge option is used to combine two fields that share a common boundary.
This is very useful if you plant the same crop in two adjacent fields at the same time
and there is no recognizable boundary where one field stops and the other starts.
For detailed instructions on merging objects, refer to the helps.

Splitting Objects

The Split option is used when a field needs to be cut into one or more sections.
This is useful when planting more than one crop in a specific field. For detailed
instructions on splitting objects, refer to the helps.
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Using Images

Aerial photos or other types of scanned images can be displayed on the screen to
trace features such as fields, ponds, barns, fences, and other important structures
and landmarks. Scanners, which work something like a photocopying machine,
produce computer images of paper maps that can be read by your computer and
used as a backdrop for tracing your maps.

Site Pro also has a Get from the Web feature that can be used to download free
government imagery from the internet into Site Pro.  This feature provides a very
easy way of getting high-resolution imagery that is geo-referenced.  This feature is
discussed in more detail in the chapter titled Creating a Map.  When these maps
are used, there is typically no reason to use other imagery such as scanned FSA
maps.

This section of the manual covers the use of other types of imagery such as scanned
maps and other types of satellite and aerial imagery.

Calibrating a Scanned Image
Normally when you use an image such as an aerial photo, it will not be to scale
(which means when you trace a field you will not get the correct acreage). Before
an image may be used, it must be calibrated. Calibrating an image scales the
map so that fields are close to their appropriate size. It also turns the map so that
North is to the top and East is to the right.
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To access the calibration program, select the calibrate option in Site Pro. On com-
puters with limited memory, you may access the calibration program through the
start menu, thus eliminating the overhead of the Site Pro program.

Once the map is calibrated, you may load as many maps as your computer has
memory resources for.

Remember, in most situations your maps do not need to be precise. However,
through calibration, you can make your map more accurate. If you are having
problems getting your maps precisely calibrated, do not worry about it.

Full Calibration

This is the most thorough way of calibrating without GPS. This calibration scales
the map as well as rotates it so that North is to the top and East is to the right. With
the Full Calibrate option, you will need to draw two lines; one that runs North-
South and the other East-West. You must also know the distance the two lines
represent. Roads or boundaries are the best features to use for this.

The length and direction of each line needs to be entered. The map will then be
calibrated according to this information. This may take some time depending on
the speed of your computer.

Scale & Rotate

This option is used when you can identify two points on your map that are a known
distance apart and only one line points North, South, East, or West.

Scale

This option is used when you can identify two points on your map that are a known
distance apart, but are not on a North-South or East-West line, or the map is al-
ready pointing in the correct direction.
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Rotate

This option is used when you can identify one line that points North, South, East, or
West but cannot identify any known distances. Since Rotate does not change the
scale of the map, it will often be used in conjunction with Scale by Area or Scale by
Percent.

Scale by Area

This option is used to scale the map without rotating it and should be used when
you have a map that has no lines (such as roads or field boundaries) that are a
known distance. With this option, you may trace a field and enter its size. The
entire map will be scaled accordingly.

Scale by Percent

This option allows you to increase or decrease the scale of the map by a percent-
age. It is usually used if you are unable to use any of the previously mentioned
options.

Changing the Appearance of the Scanned
Image

Changing Contrast, Sharpening, and Smoothing

These features may be used to improve the clarity of your map. Be sure to save
your map before you do this in case it does not achieve the desired effect.

Half Resolution

Reduces the resolution of your map. In many cases a scanned map's resolution
may be cut in half with no significant difference in appearance. The advantage of
Half Resolution is that the map can be displayed in Site Pro much more quickly,
and it only requires one-fourth of the memory (RAM).
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Saving Your Calibrated Map
Once the map has been calibrated, it is important to save the new image to your
hard drive. Use the Save option to save the map using the same name as before,
which will replace the original map. To save the calibrated map with a new name,
select the Save As option. We suggest using the Save As option so that the
original is not destroyed.

Save Selected

Save Selected allows you to select an area of your map (with the Select tool) and
save just the area that was chosen. This works well when you have a large map,
but only a small part of the map will be needed.

Loading an Image
Loading an image allows you to use it to trace field boundaries. In the Backdrop
area, select the Load option.

Warning: Images will slow down a computer. Unless you have a fast computer
with plenty of RAM, do not display more than two or three images at a time.
Images are usually used just for tracing and are then removed from display.

Changing the way Images are Displayed

Moving Images

Once an image is loaded into Site Pro, it can be moved to align with other areas
on the drawing screen. Use the Move option from the Backdrop menu.
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Changing the Sort Order of Images

Site Pro will allow you to open as many backdrops (images) on your farming win-
dow as your computer’s memory will allow. If two backdrops overlap, the backdrop
that is listed first will be the one that is visible. Use the Sort option from the Back-
drop menu to change the display order of the images.

Removing Images that are Displayed

Removing the images will not erase them from the hard drive or floppy diskette.
This will just remove them from the drawing screen. Normally you do not want to
display images all the time because this slows down the program when you are
displaying the drawing area. We recommend removing the images when they are
not in use. When you reload the images, they will load in the same position they
were in before they were removed.  If  the images are on a separate layer (that only
contains the images), then it is only necessary to remove the layer from display.

Calibrating World files
Geo-referenced image files, including geo-tiff, tfw, jpw and bpw files, may be loaded

into Farm Works along with their geographic coordinates.  Select the Calibrate

button from the Backdrop Tools button bar and click the Open   button to
select the location of the file to be loaded.  If the file has imbedded GPS data, the
program will prompt you to calibrate the image with this data.  This file may be
saved directly into your mobile device with Farm Site Mate, if connected.  You will
need to save the calibrated image and will be able to load it as a background
image in Farm Site Pro or Farm Site Mate.

Note:  Some files, such as .tfw files, consist of 2 files:  the image file (.tif, .jpg or
.bmp) and a coordinate file (.tfw, .jpw or .bpw).  Opening the image file in the cali-
brate program will also use the related coordinate file information.
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Calibrating Images with GPS Coordinates
Real world coordinates may be obtained from road and waterway maps, or GPS
data from yield maps or a GPS receiver. These coordinates may then be used to
calibrate a scanned FSA map (or other non-referenced image) which can be used
to draw your farm.  Normally you will only want to use this image if you are unable to
use the Get from the Web feature as internet imagery will be easier to work with
and will normally be of a higher resolution than most non-referenced imagery (such
as scanned maps).

To calibrate your image with real world coordinates:

1. Road and waterway maps will be needed. These are on a CD that was
included with Site Pro.

2. Import these maps into Site Pro. Please refer to the chapter titled Creat-
ing a Map for more information.

3. In order to calibrate the image, three positions will need to be located on
the road and waterway maps that can also be located on the image. We
suggest using intersections of roads. These three points should form
some sort of triangle. The larger the area covered by the triangle the
more accurate the calibration will be.  These positions can be recorded
using the Registration Points tool in the Backdrop Tools.

The next step is to load the image into the Calibrate program. Using the Register
Points tool, locate one of the three points. Zoom into the area to get an exact point.
The Point Name that corresponds with this location can then be chosen.  After the
third point is registered, the map will be calibrated.

Save the map in the Calibrate program and reload it in Site Pro. The image can
then be loaded to a new layer with a name such as "Scanned Images".

The map will now be displayed in Farm Site Pro at the proper position (based on
the coordinates that were registered) and to the proper scale. Use the mapping
tools to draw around the fence lines of the fields.  The boundaries should be drawn
on the Main Farming Layer for the client you are working with.
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Creating a Map

Your Farm Works Software includes a CD with USGS Road and Waterway data
for an area representing one to five states.  Site Pro can read the data from this
CD to create GPS referenced road, waterway and other maps.  With these maps,
you can use the “Get from the Web” feature in Site Pro to download free; GPS
referenced imagery from the Internet.  With the roads and waterways & images,
maps can be created that will be GPS referenced.  When you take the time to
carefully draw your maps, Site Pro can give you a very accurate estimate of the
size of each field!

Loading USGS Road & Waterway Maps
U.S. Geological Survey
maps (USGS Quads) are
geo-referenced maps of
roads, waterways, railroads
and other significant fea-
tures.  Quads CDs typically
contain map data for a one
to five state area and a CD
for your area is included with
Site Pro.  To load the maps
for your farm into Site Pro:

1. Select Map Setup from the File menu.  The Map Setup box will appear.

2. Insert the USGS Quads CD into your CD drive and select the Drive from
the drop-down list.
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3. Select the States to Import from the list to load maps with county bound-
aries.

4. Select Import United States Map to load a map of all US state bound-
aries.

5. Select Activate USGS Quads Map.  This will make the quads layer, which
is used for selecting the area of your farm, your active layer once it is im-
ported.

6. Click OK to load the selected maps.  You will see a map of the United
States on the screen with county boundaries for the states from step #3.

7. Use the Zoom  tool  to zoom in on
the area where your farm is located.
You will now see a series of yellow
squares.  Each yellow square repre-
sents a quad, which is an area that
you can import road and waterway
data for.

8. Using the Pointer  Tool, select the quads to import.  Hold down the
Ctrl or Shift key on your keyboard to
select multiple quads or click and drag
to rubber band a section.  Selected
quads will have a gray crosshatch pat-
tern.

9. Right click with your mouse and select
Import Quads from the menu.  The Im-
port USGS Quads box will appear.

10.Select the type of data you wish to Import.  Each data type will be loaded to
a separate layer.

a. Roads and Trails:  Includes streets, highways and roads.
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b. Waterways:  Includes lakes, rivers and creeks.
c. Railroads:  Includes major railroads that have

been mapped.
d. Misc. Transportation:  Includes features such

as major pipelines and high overhead power
lines.

11. If your quads border a state boundary, they may be avail-
able on more than one CD.  In that case, you will need to
select the CD # from which you are loading the quads.
The CD # is written on the front of the CD.

12.Click OK to load the quads for your area.

13. In the Import USGS Quads box select your CD-ROM Drive Letter from
the drop-down list and click OK.  Depending on the number of quads se-
lected and the speed of your computer, it may take several minutes to im-
port the quads.  Each type of data (roads, waterways, etc.) for each quad
will be loaded onto a separate layer.  These layers will all be assigned to a
"Common" client so they can be shared between all of your individual cli-
ents.

14.After the quads have been loaded, switch to the Layers tab as shown on
the right.

15.Select the Layer Management button.  The Layer Management box will
appear.  Available Layers and Displayed Layers will be listed.

16.Available layers (which includes the newly imported road and waterway
layers) are listed under clients in folders.  Click on a plus + sign to view
the contents.  New Clients may be added by selecting New then Client
from the File menu in Layer Management.

17.Remove the US Quad Layer from the Displayed Layers list and add the
Main Farming Layer for the Client that you are working with to the Dis-
played Layers list.  The Main Farming Layer is the layer where you will draw
field boundaries.  This is also the layer that will be used for field records.
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Deleting Extra Roads & Waterways
You may find that the quads give you more data than you need.  The following steps
will help you to delete data from the USGS Quad maps that you will not need, such
as roads and waterways that are not on your farm.

1. Select the Layer Management  button to go to Layer

Management and use the Remove All  button to remove all layers

from display.
2. Click and drag the Roads folder from the Available Layers (under the

Common client) to the Displayed Layers.  The result is that all roads will
be displayed.

3. Select the Done button and the layers will be displayed.  If all maps are not
visible, select the  Zoom All button (located in the lower left corner of the
map screen).

4. The Layers tab on the left will list the layers that are displayed.  The top layer
(known as the Active Layer) is the layer you will be working with.  Use the
Pointer Tool to click and drag to select any lines on the Active Layer that
you would like to delete.  Multiple areas may be selected by using the Ctrl
key on your keyboard and clicking and dragging.  Selected lines will have
dotted lines and will be flashing.

5. Right-click and select Delete and the lines will be deleted.
6. Select the next layer that you wish to work with (in the Layers tab) and select

the Top  button to make the layer the top/Active Layer so you can delete

Items may be removed from the Displayed Layers by double clicking on
them.  To add an item to the Displayed Layers list, double click on the item
in the Available Layers.  Items may also be added or removed by clicking
on them and using the arrows between the lists.  The bottom arrow will
remove all items from the display.

18.Select the Done button in Layer Management to display the selected lay-
ers.  Site Pro will automatically color the roads red, the waterways blue, the
railroads black and the misc. transportation green.
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Setting up a Startup Combination of Maps for
Display
Each time that you go into Site Pro, the program can display a default combination
of maps.  The following section will show you how to set the program up so so a
default combination of
layerw (such as Roads &
Waterways) will be dis-
played at startup:

1. Select the Layer
M a n a g e m e n t

button to go to
Layer Manage-
ment and use the
Remove All

 button to

remove all layers
from display.

2. Select the layers to be displayed (in the Available Layers section) and
move them to the Displayed Layers area.

3. In Layer Management, select Save as Startup from the File menu.  This
will cause Site Pro to load this combination of layers each time you start the
program.

4. Select the Done button and the layers will be displayed.

the extra lines on this layer.
7. Repeat step #6 for each of the layers that are displayed.
8. Repeat this entire process for Waterway, Railroad and Misc. Transporta-

tion maps so each map layer contains only the data that you wish to use.
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Using Aerial Photos from the Internet
Site Pro includes a method to quickly and easily download free, geo-referenced
images from the Internet.  To obtain the aerial images, you will need to know at
least one geographic coordinate in your area and have an active Internet con-
nection.  Coordinates may be obtained from the USGS road and waterway
maps that you have loaded into Site Pro.

Registering a Point

1. To begin you will need to obtain at least one set of GPS coordinates that
are to the North and West of the farm being mapped.  The easiest way to
obtain these coordinates is to use USGS road and waterway maps that
have been loaded into Site Pro.  Select the Layer Management

 button to go to Layer Management and display the

road and waterway layers.

2. Next switch to the Backdrop Tools and click on the Registration
Points  button.  The Registration Points box will appear.

3. Click on a point on the map that represents
the Northwest corner of the farm.  The coordi-
nates will appear in the Registration Points
box.

4. Enter a Description that defines the location
in terms you will understand later:  Smith
Farm NW, for example.

5. Click Record to save the information and
click Done to close the Registration Points
box.
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Downloading and Calibrating the Image

1. Select the Calibrate  button from the Backdrop Tools button bar.  The
Calibrate Image screen will appear.

2. Select the Get From Web  button.  The Enter Coordinates box will
appear.

3. Select the Saved Location from the drop-down list for the point from step#4
in the previous section:  Smith Farm NW, for example.  Alternately, you may
enter the coordinates for the point.  Be sure to select Approx. Top Left
Corner for the Location of Point option.  Click OK to continue.

4. The image will automatically be down-
loaded from the Internet and will be
calibrated with geo-referencing data.
The downloaded image covers an area
approximately 1.2 miles East and
South from the selected point.  Note
that depending on the download speed
of your Internet connection, this process
can take anywhere from a minute to
several minutes.

5. The map will now be displayed in the
Calibrate screen.  Select the Save As

 button to save the image.
6. The Save As box will appear.  Enter a name for the file (such as Smith

Farm).  The program will default to saving the file in the
C:\Sitepro\Images\Backdrop folder/directory.

7. Click Save and the image will be saved.
8. Select Exit from the File menu to close out of the Calibrate screen and

return to Site Pro.

Loading the Image

1. Go to Layer Management and create a new category under the Common
client (select New then Category from the File menu of Layer Management).
Give the category a name such as "Imagery" or "Internet Imagery".

2. Select  the Common client and select New then Layer from the File menu of
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Layer Management.  Create a new layer for the image.  The layer name will
describe the area covered by the image (such as "Smith Farm" or "West
Half of Smith Farm").  This layer should be a Lines Only layer.

3. Display the new layer as the top/Active Layer.  Then click Done to exit
Layer Management.

4.  To load the image onto the layer, select the Load  button in the Back-
drop Tools.  The Load backdrop box will appear.

2. Select the directory in which the calibrated image was saved.  This will
normally be the C:\Sitepro\Images\Backdrop folder, which is what the pro-
gram will default to.

3. Select the file from Step #6 from the previous section.
4. Select the Open button to load the image onto the current Active Layer.

The scanned map will appear on the screen.
5. If the image does not cover your entire farm, repeat this process, for the

next area that is needed.  If desired you can load more than one image onto
the same layer.  However, it is not recomended that you load too many
images as this can slow down the display of the maps.

The USGS Roads & Waterways and the imagery are not perfect and there may be
times where the maps do not line up exactly.  Normally this is due to one of the
maps being shifted.  To fix this and make the maps line up:

1. Display the Road & Waterway Layers along with the downloaded imagery.
Make sure that the layer with the imagery is the top/Active Layer.

2. Select the Zoom Tool  and zoom in on an intersection of two roads or a
road and a waterway that is visible on the imagery.

3. Select the Move   button in the Backdrop Tools.
4. Position your cursor over the intersection on the image.  Then hold down

the left-mouse button until your pointer turns to a hand and drag the image
until your cursor is over the same intersection on the USGS roads and wa-
terways.

After all of the images are loaded and lined up with the roads and waterways, you
can start drawing and defining your field boundaries on the Main Farming Layer
for the client you are working with.  Fields will typically be drawn using the Multi-
Line tool (from the Mapping Tools toolbar).  With the Multi-Line tool, you will left-
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click around the corners of each field to trace the boundary.  When the boundary is
completely drawn, you can right-click to stop drawing.

Hint:  When drawing a boundary it is very important to not leave gaps.  Gaps can
be caused by not stopping a boundary where it was started.  To insure that there
are no gaps, turn on the End Point tool by pressing the <e> key on your key-
board before you click on the last corner of the field (the same corner where you
started drawing).  This will snap the end of the last line to the start of the first line.
Pressing the <e> key again will turn off the End Point tool.

Once a field is drawn, it can be defined by selecting the Define Objects tool from
the Mapping Tools toolbar and clicking inside the boundary.  When this is done,
Site Pro will display the acreage for the field and will ask for details such as the
field name, landlord and other important information.

The Drawing Tools section of this manual includes more information on using the
Multi-Line, End Point and Define Objects tools along with information on other
important tools that can be used to create maps.  Additionally, the Farm Works
Tutorial and Helps include more information on creating maps.
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Overview
The ability to access information collected from several sources is crucial to mak-
ing accurate and informed recommendations.  This information may come from
yield monitors, soil testing labs,  scouting reports, or even the government, and it
all needs to be mapped.  Site Pro allows access to this information through a
process known as importing.

The information collected and stored in Site Pro may be useful to other software
and hardware you wish to use.  This information, however, is in a format that the
other program may not understand and needs to be converted. This process of
converting data from Site Pro into other formats is known as exporting.

Importing
There are several types of files that can be imported with Site Pro.  Examples
include data from universities and government agencies,  maps from the US Geo-
logical Survey (USGS), and ASCII text files from soil labs.  The list of supported
imports is continually growing and a complete list is available by contacting Farm
Works Software.

The process of importing data has a few basic steps that are the same regardless
of the type of information imported.

• Choose the type of data file that you will be importing.  This includes deciding
if the data to be imported will be represented as lines.

Importing & Exporting
Data
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• Enter the name of the file that contains the data to be imported.

• Select the layer to receive the new information.

After these questions have been answered, other information may be required to
complete the import, such as what data is in each column of an ASCII file.

The layer you are importing to may be set to become the Active Layer by marking
the Activate Layer checkmark.  A defined zoom may also be saved that encom-
passes the newly imported data by selecting the Create Zoom View checkmark.
Finally, a legend by which to color the data may also be automatically created by
selecting the Create Legend checkmark.

It is important that you carefully select the layer to which you wish to import the data.
Information such as road maps should be kept on a separate layer from water-
ways. Similarly, soil tests for different years should be imported to separate layers.
The way in which the information is organized in Site Pro will greatly affect perfor-
mance.

Generic Imports

The Generic Import feature is used to import any ASCII text file that is delimited by
commas, tabs, or spaces.  This is the type of import that can be used to map
information provided by soil testing labs.  Generic Import is called generic be-
cause the file to be imported can be organized in many different ways.  The key
feature of this import is that the data items in the destination layer may be mapped
to any column in the source file.  The data item on the layer may also be set to a
constant value that all records will have.

Data may also be imported and added to points or areas already on the layer by
matching a value from the file with one of the points previously mapped.  For ex-
ample, you could collect soil samples, mark their location on a soil test layer, and
give each a sample number.  Then when the results are returned from the lab, that
sample number can be used by generic import to match each record in the data
file to the corresponding point already on the layer.
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Exporting
There are several types of files that may be exported with Site Pro for use by other
software and hardware.  Examples include the export for spot spraying applica-
tions, and the export of the entire layer for use by other Farm Works Software
programs.

Generic Exports
The Generic Export feature is used to export the information on the layer in an
ASCII text file. This type of export allows for either commas, tabs, or spaces to be
used to delimit the different data items stored on the layer.  The organization of the
resulting export is also configurable so that each column represents the desired
data item.
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Quick Yields

Overview
The Quick Yield Import box may be used to import any yield map. The Quick Yield
Import will automatically default the values for key steps such as creating the leg-
end and activating the layer after the import. It will also automatically create aver-
aged and contoured views. To create your own legend, go to the Edit Legend box
in the Quick Yields area after importing.

Quick Yield Tools
The Quick Yield Import is used to create a yield map utilizing a “wizard” that takes
you step-by-step through the process.  The wizard features different screens where
you will enter different information.  The bottom of the box will include a Next button
that is used to proceed through each step of the yield mapping process.  Addition-
ally, a Back button will be available so you may go back and check or change any
information that was previously entered.  The following is a brief overview of some
of the information entered in each screen of the wizard, note that some of these
screens will only be available for certain types of yield data:

• Filename – Use the Browse button to select the yield file that is being im-
ported.  When doing this, you will normally select the PC card slot on your
computer to find the file to be loaded.
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• File Type – Select the type of yield file that you are loading.  Site Pro will
normally be able to detect the type of file and will not ask for this information.

• Loads – This area will list each of the fields (as entered on the yield monitor)
that are in the selected file.  If you do not wish to import a field, simply turn off
the red checkmark to the left of the field name.  Use the Field column to select
the name of each field.  These are the names of the fields as they are defined
on the Main Layer in Site Pro.  If the field has not yet been defined on the Main
Layer, select <Add> and set the field up.  Use the Commodity column to
select the crop for each field.  Select <Add/Edit> to set up or change a com-
modity.  Note that the commodity will include information such as Crop
Weight, Dry Moisture, Shrink Percent and Shrink Increment.  These
settings will affect the way the program computes the dry yield that will be
used for your map. You will also need to select a Combine to use for creating
the yield map.  Select <Add/Edit> to set up or change information about the
combine being used.  The Combine settings will include information such as
the Start, Stop, and Combine Delays.  These settings will be used to deter-
mine the positioning of yield points.  The Loads area will also include an
option to “Save a copy of the card image or file”.  This is useful for making a
backup of a yield file.

• Layers – This is where the layer for each field being imported will be se-
lected.  Note that normally it is best to import the yield data for each individual
field onto a separate layer.  Site Pro will default to creating a new layer that
includes the field name, year and commodity as the layer name.  To use a
different layer name, select the layers button to the right and you will be able to
select a previously created layer or create a layer with your own name.

• Markers – If the yield data includes field markers, you will be able to assign
the appropriate attribute that each button or marker represents.

• Finish – Once all of the requested information has been entered, you will see
the finish screen.  At this point you can use the Back button to review any of
the information that was previously entered.  Select the Finish button and the
yield data will be imported and your map will be created.
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Once the yield map has been imported, there are several different areas that can
be used to display legends, average views, contoured views, etc.

The following is a list of quick yield functions:

• Yield—Displays the map with yield data.

• Moisture—Displays the map using moisture data.

• Elevation—Displays the map using elevation data when it is available.

• Base Data—This view of the data will show the raw data points with a 30 foot
by 30 foot square for each point.

• Average—This view of the data will show the gridded average of the data.
The average is based on a 50 foot grid. The size of the grid may be changed
by right-clicking on the Average button and entering the desired size.

• Contour—This view of the data will show a contoured view of the yields. The
contours will be based on a 50 foot gridded average.

• Field Average—This view of the data will show the field colored based on the
average yield for the entire field. Right-click on the field and select Properties
to display detailed information for the field.

• Layers—The Open Yield Layer box is used to change the yield map or layer
that is displayed or to display additional yield map layers.

• Coordinates—This displays the Coordinates box which will show the exact
coordinates where the cursor is at on the map. This can be used to check that
coordinates of lines or objects are correct.

• Legend—Default legend which is based on the information imported. This
legend can be changed through the Edit-Legend area.
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Overview
The options in the File menu perform important tasks, such as making backups,
printing maps, and setting preferences for Site Pro’s working environment.

Saving the Map
Any change to the map is automatically saved when the layer is removed from the
display or when the program is closed.  However, if you have been working on the
map and do not want to risk losing your changes due to a power failure or some
other computer problem, you can have Site Pro save immediately.  To save any
changes to the map, select Save Map from the File menu.

Making a Backup
The information stored in Site Pro is very valuable and precautions should be taken
to ensure its safety.  The Make Backup option on the File menu can help to pre-
vent the loss of this important data.  This option copies all the information stored in
Site Pro to a compressed file that can be  later restored in the event that data is
lost or another copy of the information is needed on another computer.

This option makes a backup of all the information in Site Pro.  Individual layers
may be archived by using  the Archive Layer option on the right-click menu in the
Layer Management dialog box.

The File Menu
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It is recommended that backups be made regularly, and that multiple sets of dis-
kettes be used to store the archived data.  For example, you may want to use
seven sets of diskettes, one for each day of the week, and use each set on its
corresponding day.  Every now and then a backup should be made and stored in a
safe place such as a fire box or off site to prevent data loss in case of major
disaster.

Restoring from a Backup
If the need arises that you must retrieve the information from a backup, the Re-
store from Backup option on the File menu may be used.  This option will re-
place all the information currently stored in Site Pro with the data in the backup file.

Warning:  This will delete all the information currently in Site Pro and will
only return the data that is in the backup file.  Any layers or information that
have been added since the backup was made will be lost.

Printing the Map
It is often helpful to have a hard copy of the map printed so that it can be referenced
when you are not at your computer.  To obtain a printout of the map, select Print
from the File menu.  There are several options that can be set at this time.

• Output:  Select Bitmap Image when printing map to file. Select Printer
when printing to paper.  You have the option to enter the number of copies to
be printed.

• Options:  The Layout of a printed map has two standard settings: Standard-
Portrait and Standard-Landscape.  Select <Add/Edit> to create a new Map
Print Layout.  Select the items to print (such as a legend, scale, logo, etc.),
then click and drag images to their desired location. You may adjust the print
margins as well as the display margins.  Entering a Description and
selecting Record will save the new Layout.

• Print Logos, Compass and Scale:  The Farm Works logo, a scale bar and
a compass may be printed on your map.  You may also print your personal
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Logo. (For best results, use a 300x150 pixel bitmap.)

• Use Printer Resolution:  Most printers can print at a much higher resolution
than that of the screen.  Printing at the printer resolution will make text and
lines appear much sharper.  Objects are printed with a solid pattern when this
option is selected. The patterns used on the screen have stripes that are only
one or two pixels wide and are not recognizable at printer resolution. As such,
printer resolution should not be used when you wish to print patterns.

• Print Outlines and Text Only:  This option allows for the map to be printed
without filling any of the objects with a color or pattern.  This is useful when
printing maps that will be used to make notes about areas of the course.

• Title and Map Info:  Title allows you to enter a name for the map.  Info allows
you to add a description or explanation to the printed map.

Area:  There are several options that determine which area of the map will be
printed.

• Window:  The area to be printed will include all items currently visible on the
screen.

• All:  Every item on all currently loaded layers will be included in the area to
print.

• Select Area:  This option allows you to select the exact area of the map that
will be printed. A red box representing the area to be printed will appear on
the screen.  This box may be moved and sized by dragging it with the left
mouse button.

• Specific Area:  Select this option to print an area centered on a specific
object.

Scale:  The scale will determine the size at which items on the map are printed.

• Best Fit:  The program will calculate the largest scale that will fit all of the
selected area on one printed page.
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• Scale:  This option allows the map to be printed at a specific scale.  This is
useful when several maps need to have a consistent scale.  The selected
area will be centered and may extend beyond the edges of the page if the
scale is too small.

To select a printer or change the printer’s settings, use the Printer Setup option
on the File menu or the button in the Print Map dialog box.

• DPI:  This stands for Dots Per Inch.  This setting is useful when the output is
to have specific scale. This value is ignored when using Best Fit for the scale.

Logo Options

Printed maps may be customized by adding personal logos and/or changing the
appearance of the Farm Works logo. Logos may be printed:  full color, black and
white, or a single line of text.These options may be accessed by selecting Prefer-
ences · Logo Options on the File menu.  You may also select the Logo Opt.
button from the Print Map screen.

If you wish to add your own logo to the map, it will be printed directly above the
Farm Works logo in the lower right corner, but may be moved anywhere on the
map. Personal logos may be created using Windows Paintbrush, and should be
saved as either a 16 or 256 color bitmap (.bmp).  For best results personal logos
should be 300 x 150 pixels.

Selecting a Measurement System
Site Pro may be configured to use US/English or metric units as well as to express
coordinates in a variety of systems.  To change these settings use the Prefer-
ences · Measurements option on the File menu.  The choice of measurement
system should be made prior to defining fields, so that the calculated area will be
expressed in the desired units. Changing this setting does not change the values
or units of the areas already defined or supplies already used.

There are several ways in which Site Pro can express coordinates, including deci-
mal degrees, degrees - decimal minutes, degrees - minutes - seconds,  state
plane, and Universal Transverse Mercator (UTM).
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Map Setup
Site Pro includes the ability to load in a map of the United States as well as county
maps for every state in the continental US.  These maps will be on the CD that has
the USGS roads and waterways.  The Map Setup box is where you will load this
road and waterway data from the USGS CD.

The USGS Quads CDs from Farm Works also include road, waterway, railroad
and other USGS maps.  A  CD with data for your area should have been included
with the Farm Works program CD.

To complete Map Setup:

1.  Select Map Setup from the File menu.

2.  If you wish to import US State and/or County maps, insert the USGS quads CD
into your computer and select the proper Disk Drive in the upper right-hand corner
of the Map Setup box.

3.  Select the States that you wish to import.  Note that you can select as many
states as you need.  The program will import the county boundaries for the states
that you select.

4.  Select the Import United States Map option to load a map of the United States
that shows all state boundaries off of your program or USGS Quads CD.

5.  Select the option to Activate USGS Quad Map to load the US Quad Layer as
the active layer.

6.  Select the OK button to load the desired maps.

7.  If you selected the option to Activate USGS Quad Map, then you will see map(s)
of the state(s) that you selected.  The USGS maps are divided into rectangular
sections (called "Quads") that are roughly 11 by 17 miles for most areas of the
United States.  The map will have yellow squares that represent the different quads
for the state(s) that you selected.
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8.  Use the Zoom Tool to zoom in on the area that you are working with and use the
Pointer Tool to select the quads that you want.  You can select the desired quads
by holding down the <shift> or <ctrl> keys on your keyboard and clicking on each
square.  Alternately, you can click and drag to form a "rubber-band" that surrounds
the quads that you need.  The quads that you have selected will be displayed with
a gray cross-hatch pattern.

9.  After you have selected all of the desired Quads, right-click and select Import
USGS Quads.

10.  To cancel out of the import process, right-click and choose Cancel Quad
Import.

11.  Once imported, each type of map (road, waterway, railroad and misc.) will be
put onto a separate layer for each quad.  These layers will be grouped by category
in the Common client.  You may display these layers from the Layer Manage-
ment box.
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Overview
Once the information is collected, imported, and stored in Site Pro, the important
process of analyzing the data is ready to begin.  The maps generated with Site
Pro will become a powerful tool in helping you make accurate recommendations
to your clients.  By identifying trouble spots and their effect on yield, you will be
better able to assist your clients to raise crops more profitably.

Layers Tab
The Layers tab shows which layers are displayed.
Once displayed, a layer’s characteristics can be
changed to highlight an aspect of the data or to make
this layer distinguishable from other layers.  For ex-
ample, the color of the lines can help distinguish be-
tween a road layer and a waterway layer.

Properties

To change a Layer's Name, Category or any of its

Attributes, select the layer then select the Properties button.   Properties may

also be accessed from each layer's right-click menu.

Display Properties

There are several characteristics that affect how the information on a layer is dis-

Viewing and
Analyzing Data
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played.  A layer’s appearance may be changed by selecting it from the Layer Win-

dow and clicking the Display Properties button or by right-clicking on it, and

selecting Layer Display from the menu.  Some of the options that affect a layer’s
appearance include:

• Visible/Hidden checkmarks:  used to make a particular type of item on the
layer be visible, such as showing or not showing lines, text, backdrops, or
data points.

• Lines:  allows for the color and width of lines on the layer to be changed.

• Data Points/Areas:  allows for the data to be represented in many different
ways, such as a grid of average values or an average based on soil type.  Any
views that are no longer needed may be deleted by using the button to the
right of the list.

• Point Size:  the size of the dots that represent point data on the layer.

• Borders on Points:  allows for the points to be outlined  to make individual
points more distinct.

• Clip Points to Field Boundaries:  points and average grids generated for
yield maps can be made to stay within their associated field boundaries as
defined on the Main Layer.  If the field is drawn incorrectly, the points may not
display at all when this option is selected.  Therefore it is very important that
the fields be drawn and defined correctly on the Main Layer.

• Color Scheme:  allows for the points or data areas to be colored based on
any of the legends that have been created for this layer.  By changing the
legend, the data item that determines the color can also be changed.  For
example, on a yield layer you may have one legend for yield and another for
moisture. If there are any data items that are of the type Pattern, they will
appear as choices along with the list of legends and can be used to determine
an object’s color. This option also allows for all the data on the layer to be
drawn using only one color.
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Show Me

The Show Me  option allows you to pick and choose the attributes that are
displayed.  By using the Edit button, attributes may be limited by assigning a range
to them . In this way, areas of high moisture and/or low yields, for example, may be
isolated.  This option is covered in more detail at the end of this chapter.

View Legend 

The way in which items are colored is usually determined by which legend the layer
is currently using.  A legend is an association between a particular choice or range
of values and a color pattern.  To edit or add a legend to a layer, select the layer in
the Layer Window and click the View Legend button or right-click on the layer and
select Edit Legend from the menu. Each layer may have many different legends.

Zoom Layer  

The Zoom Layer button allows you to zoom in to a selected layer automatically.

Remove from Display 

This button allows you to remove a selected layer automatically.

Editing/Creating Legends

The Edit Legend box is used to assign colors to data on a layer.  Colors will be
displayed on the points or areas on the map and creates a legend that may be
printed with the map.   The Edit Legend box is where new legends may be created
and existing legends may be modified.

The Current Legend drop-down list is used to select a previously created leg-
end.  Once selected, a legend may be modified or deleted.  To create a new leg-
end, select <New> from the Current Legend drop-down list then enter a Legend
Name and select the Data Item to be used.  The Data Item drop-down list will
display all numerical and choice data items that are available on the selected layer.
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Once a Legend Name and Data Item have
been selected, the legend may be created.
The Legend Properties box will include an
area where the actual legend will be dis-
played.  In this area you can change the
numbers that represent the ranges or se-
lect the choice items to be used.  New
ranges may be added to the top and bot-
tom of the legend by using the  buttons.
The  buttons can be used to remove

rows from the legend.  Additionally, the
color buttons to the right of each range may be used to assign colors to ranges of
numbers or choices.

When the Range Descriptions option is enabled, a description can be added to
each line of the legend.  This can be useful for adding descriptions such as “High”,
“Medium” and “Low” that will be displayed with the numeric ranges.

The Ranges, Choices, Colors, and Templates tabs in the Legend Properties
box can be used to assign values and colors to a legend.

The Ranges tab can be used to assign ranges of numbers to a legend.  When the
Equal Ranges option is used, entering high or low values as well as the spacing or
number of divisions can create a legend.  You must enter three of the four values
and the program will compute the fourth value.  The Statistical option may be used
to create a legend statistically based on the data that is on the layer.  When doing
this there will be options for entering the number of divisions to be used along with
other information.  Information including the number of data items, maximum and
minimum values, and the average and standard deviation of the values will be
displayed.  The Equal Count option may be used to create the legend so that each
line of the legend contains the same number of data items.  Once the desired
settings have been entered, the Apply button may be used to update the actual
legend.



73

The Choices tab can be used with a legend that has choice data (such as soil
types or other data that contains text) to quickly assign the desired choices to the
legend.  When the desired choices have been selected, the Apply button may be
used to update the actual legend.

The Colors tab is used to quickly fill in the colors for the legend.  The Spectrum
area can be used to select different methods of assigning colors.  When the Nar-
row or Wide method is used, colors for the top and bottom of the legend may be
selected, and the colors in between will be assigned based on the color spectrum.
When 3 Color is used, you will be able to assign a color for the top, bottom and
middle of the legend.  Items in between are assigned colors automatically.  The
Contrast option assigns a variety of colors to the legend.   Once the desired colors
have been selected, the Apply button can be used to update the actual legend.

The Templates tab can be used for sharing different numeric legends between
layers.  The Templates tab will display a listing of all the legend templates that may
currently be shared between layers.  To add to this list, enter a Description for the
template and click on the Add button and the legend that is currently displayed will
be added to the list.  To use a previously created template, first select the template
name and then select the Apply button and the legend will be filled in with the
values and colors from the template.  The Update button can be used to update a
selected template with the settings and colors on the left.  The Delete button can
be used to remove previously created template. Once the desired legend has
been created, select the Record then Done buttons to display the data on the
Active Layer with the legend.

View Legends

The legend that a layer is currently using may be displayed and utilized as a refer-
ence while working with the layer.  To display or hide a legend, right-click on the
layer in the Layer Window and select View Legend from the menu.  To display a
legend on a printed map, select the Print Legend option before printing.
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Views
The ability of Site Pro to aggregate and interpolate data is a useful tool when
looking for trends and correlations between variables.  Different views may be

generated from the data using the Smoothing button  in the Layer Tools.

Average

The Average method creates a grid of points, where each point represents the
average of all the points contained in that grid square.  This method is useful when
there are many points in each grid square, as with yield data.  Grid squares that do
not contain any points are left blank.  This makes Average less useful for sparsely
distributed points, such as soil samples.  The number of points in an Average view
will usually be much fewer than the number of points in the base data.  This reduc-
tion in the number of points not only clarifies areas that need attention, it increases
performance when loading and displaying the layer.

Smooth

The Smooth method also generates a grid of points.  Each point represents a
weighted average of the data points nearest the center of the grid square.  The
weighting of each point is determined by its distance from the center of the grid
square.  Each square has a value calculated, regardless of whether or not any
points are actually contained within its boundaries. This method is useful when the
data is sparse, as with soil test data.  The parameters used in the calculations can
be changed by selecting the Options button when creating the view.

Average & Contour

The Average & Contour method uses the grid generated by the Average method
to calculate a contour map of the data.  A contour map is an area map where each
area represents one line on the legend.  Contour maps are very useful to outline
large areas of the field that have similar values.  Since this method uses the Aver-
age method, it has the same limitations as the Average method, and should be
used when each grid square contains many points.
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Smooth & Contour

The Smooth & Contour method uses the grid generated by the Smooth method to
calculate a contour map of the data.  A contour map is an area map, where each
area represents one line on the legend.  Contour maps are very useful to outline
large areas of the field that have similar values.  Since this method uses the Smooth
method, it has the same limitations as the Smooth method, and should be used
when there is a sparse distribution of points.

Average Polygons

The ability to combine the information from two layers is a key feature in Site Pro.
The Average Polygons method allows for the average value for an entire area from
one layer to be used to calculate a view for data on another layer.  For example,
you can use this method to find the average yield for each soil type in a field.  To
generate such a view, use the Pointer tool to select the areas that represent the
soil types contained in the field.  Then right-click and select Average Polygons
from the menu.  In the dialog box, select the layer that contains the yield information
to be averaged.  The resulting view will contain objects that correspond to the soil
type areas and will have the average yield as a data item.

Show Me 

The ability to query and filter the information is an important feature for any system
that deals with large amounts of data. To filter information in Site Pro, right-click on
the layer in the Layer Window and select Show Me from the menu.  Each data
attribute for the layer will be listed.  The data points or areas displayed can be
filtered by pressing the Edit button and entering the desired range of values that
the data must fit.  For example, to view just those points that have a yield less than
20 bushels, you would enter 20 for the upper limit.  More than one attribute may be
used when filtering.  When multiple attributes are used, the data must fit all se-
lected filters to be displayed.

To quickly return to viewing all data, select the Make All Data Visible button in the
Show Me dialog box.  This will remove the Use checkmarks from all the attribute
filters that signal whether or not they are being used.
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Overview
One of the unique features of Site Pro is its ability to record product applications.
By keeping these records, Site Pro can help you and your clients comply with EPA
regulations that require records of restricted use pesticides (RUP) be kept.  In
addition to the RUP reporting requirements, Site Pro can generate a field activity
report that lists all the product applications for a field along with a cost for each.

Setting up Supplies
The Supplies tab is where you will go to set up the
supplies you will need for your clients.  The supplies
will be added to a master list that is organized into
categories including chemicals, seed, fertilizer and
other items.  Each category will have a “+” to the left of
the name.  When you click on the “+”, the category will
open and the individual supplies will be listed below
it.  You may display or change the properties of a listed
supply by right clicking on it and selecting “Proper-
ties” or  by left-clicking on the supply and then clicking

on the  “Properties” button.  A supply may be de-
leted by clicking on it and then clicking on the  “De-
lete” button or by right-clicking on the supply and se-
lecting “Delete”.

Product Applications
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To set up a new supply, select the  “Add” button or right-click on the appropriate
category and select “Add New Supply”.  The Supply Properties box will appear.
This box will be broken into five different tabs that are used for entering informa-
tion.  These tabs include:

General

The General area is used for entering basic information about each supply.  The
following information will need to be entered:

• Description:  a unique name for the item.  Usually a brand name or variety,
such as Roundup or Pursuit.

• Part Number:  a code or reference number for the supply.  This can be used
as a reference for a number that your supplier uses or it can be used as a link
to a master supply database from another source.

• Type:  the category for the supply that is being set up.  The Type will be used
to determine the category that the supply will be listed under in the Inventory
Items box.  The Type will also determine what type of other information may
be set up for the supply as well as the types of reports that will be kept for the
supply.

• Purchased Unit:  the unit of measure that describes how the supply is
purchased.  This is the unit of measure that will be used for the total amount
of supply used on each field and the unit of measure that the unit price is
based on.

• Distributed Unit:  the unit of measure used when applying the supply to a
field.  This is the unit of measure that the application rate is expressed in.

• Conversion Factor:  the number of distributed units that are in one
purchased unit.  For example, you purchase seed corn by the bag but plant
it by the population.  The purchased unit would be “bags”, the distributed unit
would be “pop”, and the conversion factor would be 1 bag = 80,000 pop since
there are 80,000 kernels of seed corn in one bag.
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• Unit Price: the current price or cost of the product.

Chemical

The Chemical area is used for entering details about chemicals.  This area will
only be available if Herbicide, Insecticide, Fungicide, Nematicide, Rodenticide,
Fertilizer/Lime, Adjuvant, Growth Regulator, or Other Chemical is selected for the
Type in the General area.  The following information may be entered:

• Restricted Use Pesticide: marks applications of this chemical for inclusion
on Restricted Use Pesticide reports.

• Chemical Name: the name of the Active Ingredient for the chemical.  This
can usually be found on the label of the chemical.

• EPA Number: the number that the Environmental Protection Agency has
assigned to this chemical.  This can usually be found on the label of the
chemical.

• Manufacturer:  the company that makes the chemical.  This can usually be
found on the label of the chemical.

• Formulation:  the formulation of the Active Ingredient.  This can usually be
found on the label of the chemical.

• Mode of Operation:  this is how the chemical works.  Select the Mode from
the drop-down list or select <Add/Edit> to add to the list.

• Target Problems: select up to five pests (weeds or insects) that the
chemical controls.  If the desired pest is not listed select the Add/Edit
Problem List button.

Fertilizer

The Fertilizer area is used for entering details about fertilizers.  This area will only
be available if Fertilizer is selected for the Type in the General area.  The following
information can be entered:
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• %N - %P - % K: enter the Analysis percentage of Nitrogen, Phosphorous,
and Potassium for the fertilizer.  These percentages will be used to compute
the number of pounds of each item used.

• Product Weight:  this number is used to convert the quantity of fertilizer used
to pounds.  This value will be used along with the Analysis Percentages to
compute the total pounds of N, P and K used.

Pesticide Restrictions

The Pesticide Restrictions area is used to enter restricted entry information for
chemicals.  These items will be used when re-entry schedules are required under
the Workers Protections Standards.  The following information can be entered:

• Re-entry Restrictions:  Select this to indicate that the chemical has re-entry
restrictions.  Once this is enabled, you will be able to enter other information
in the Pesticide Restrictions area.

• Restricted Entry Interval:  This is the length of time (in hours) that entry to
areas treated with the chemical must be restricted.  This information should
be displayed on the label of all restricted use chemicals.

• PPE and Other Label Requirements:  This information is required if you
will be printing out Application Schedules that will be provided to people that
will be working in or near areas that have recently had the pesticide applied.
This information should be displayed on the label of all restricted use
chemicals.

• Treated Area Posting and Oral Notification Required:  Select this option
if the owner or operator is required to make a Treated Area Posting or make
Oral Notifications of the pest application to all workers.

Pattern

The Pattern area is used to select the colors and patterns that fields will have when
the supply is used in an application.  This option will only be available when a seed
is being set up or when the “Changes Field Pattern” option is enabled in the Gen-
eral tab. For seeds, the pattern should represent the crop that the seed is planting
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so that the map will always reflect the crop that is in each field.  Pattern Templates
may be used to assign a name to any selected color and pattern.  By assigning a
name, you will be able to recall the same colors and patterns for other supplies by
selecting the template name from the drop-down list.  The template names will
also be used as a legend when printing maps.  Select <Add/Edit> from the Tem-
plate drop-down list to add names to the list of templates.

Setting up Applicators
Each application of any restricted use pesticide should record the person who
actually applied the product.  To add new applicators
or edit existing ones, select Applicators from the
Setup menu.  Each applicator must be given a unique
name along with his or her chemical application license
number.

Recording Product
Applications
Once supplies and applicators have been set up, prod-
uct applications may be recorded.  To record a prod-
uct application:

1.  Go to the Supplies tab.

2.  Move the supplies that are being used to the Working Group.  This can be
done as follows:

•    Select the supply, then select the Add  button or

•     Double click on the item

3.  Make sure that the Main Layer for the client is displayed as the Active Layer.

4.  Select the field(s) that the product is being applied to.  To select multiple fields,



82

hold down the Shift or Ctrl key on your keyboard and click on each field.

5.  Right click and select Apply Working Group.

6.  The Farming box will appear so that you may enter details about the
application.

The Farming Box

The farming box is a spreadsheet in which you will enter specific information about
the application.  The table contains a column for each field involved in the applica-
tion as well as a column for any totals.  Each row in the table represents a different
piece of information that can be recorded about that application.  Information en-
tered in the total column will be distributed to the other columns based on the num-
ber of acres treated or copied to all columns for data that is not numeric such as
the chemical carrier. The main topics for input include:

• Area Farmed:  the size of the area that had product applied.  This value is
defaulted to the size of the field but may be less if the whole field was not
treated, or more if multiple passes were made.

• Date:  the date the application was completed.

• Commodity:  the crop that is growing in the field.  If there is no crop currently
in the field, select Field Prep or the crop that will be grown.

• Notation Category:  the classification this application notation should have.
Different categories can help sort out particular types of applications.  For
example, you may have categories for each of the various methods of
application you may use.

• Field Pattern:  the color pattern by which the field will be colored after
completing the operation.  This allows fields that have been treated differently
to be identified on the map.

• Applicator:  the person who applied the product.  The applicator’s license
number will be included on chemical application reports.

• Quantity, Rate, and Cost:  the amount and unit price of the product applied.
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This information can then be used to generate statements of field activity for
your client.

• Additional Chemical Information:  if the product applied is marked as
Keep Chemical Records, additional information about the application may
be entered.  This includes the chemical carrier and the carrier rate, such as
water at 10 gallons per acre.  This information is optional but will appear on
chemical reports if it is entered.

• Field and Weather Information: if the product applied is marked as Keep
Chemical Records,  information about field and weather conditions at the
time of application may be entered. This information is optional but will
appear on chemical reports if it is entered.

Removing Product Applications
The simplest way to correct a product application that was entered incorrectly is to
undo the operation and enter the correct information.  To remove an erroneous
application select Remove Product Application from the History menu.  Select
the field and the date range for which the operation was entered, and press the
Update Operation List button.  Then select the operation to remove from the list
of descriptions and press the Remove button.  This will delete the notations, chemi-
cal records, and field activity records created by this operation.

Editing Product Applications
Product applications may be edited by right clicking on the desired field and se-
lecting Operation Maintenance.  Users will be able to add an existing supplyto
the operation.  Editing the product application will update notations, chemical
records and field histories.

To edit a farming operation:

1. Right click on the desired field and select Operation Maintenance from the
pop-up menu.
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2. Highlight the product application(s) to be edited.  Use the sorting fields at the
left to narrow your selection.

For example, if you want to view only the operations that have a Type of
‘planting’ for April of 2004 – enter the Start Date as 04/01/2004, End Date
of 04/30/2004 and select ‘planting’ from the Type drop down list. Select the
Update List button to display only the operations that fit these restrictions.

The displayed operations may be further sorted by left clicking on the col
umn headings.  For example, left clicking on the Field column heading will
sort the currently displayed operations into alphabetical order by the field
name.  Left clicking on the Field column heading once more will sort the
operations in reverse alphabetical order by field name.

NOTE:  To select more than one operation, hold down the <Shift> or <Ctrl> and left
click on the desired operations.

3. Select the Edit button.  The Farming box will appear.

4. Make the necessary changes to the application.

To add a supply to an operation:

a.  Select Add-Supply from the Farming screen.  The Inventory Item
screen will appear.

b.  Open the appropriate supply category by left clicking on the ‘+’ to the left
of the category.

c.  Highlight the supply to be added.

d.  Select OK to add the supply to the application.

e.  Enter the application rate or total quantity used for of the supply added.

f.  Repeat steps a-e for each supply added to the operation.
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Merging Product Applications
Product applications may be merged by selecting Operation Maintenance from
the right-click menu of a field.  Hold down the <Ctrl> or <Shift> key and left click on
the operations to be merged.  Product applications must have the same field, crop
and type before a merge can be completed.

Editing Chemical Records
Chemical records can be edited or added without using the Apply Product menu
item.  This type of editing, however, will not change notations or field activity.  For
this reason, chemical records should usually be edited by removing the original
operation, and re-applying the product to the field or using the Edit feature in Op-
eration Maintenance.  To edit a chemical record directly, select Chemicals · Add
/ Edit Record from the History menu. This method is useful for changing informa-
tion such as the field or weather conditions.

Creating Restricted Entry Schedules
Pesticide application schedules that conform to the Worker Protection Standards
can be created with Site Pro. These schedules may be posted to warn employees
that pesticides are scheduled to be applied that will restrict entry into the field. A
map, which highlights all the fields that are currently restricted, may also be printed.

Adding a Restricted Entry Application to a Field

An application of a Restricted Entry Information (REI) chemical may be scheduled
by right-clicking on the desired field and selecting Restricted Entry from the menu.
The information requested will be used to generate worker notification postings
and a map of fields that have re-entry restrictions.

The schedule of restricted entry applications may be edited by selecting Restricted
Entry · Edit Application Schedule from the History menu.
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Printing a Restricted Entry Application Schedule

The schedule of restricted entry applications may be printed by selecting Restricted
Entry · Report from the History menu.  This report conforms to the Worker Pro-
tection Standards and may be posted for your employees.

Creating a Map of Fields with Restrictions

A map highlighting all restricted entry fields may be created by selecting Restricted
Entry from the View menu.  The Display Restricted Fields checkmark activates
the restricted entry filter.  This filter allows only those fields that have restrictions
between the specified dates to be highlighted.  This map may then be printed and
posted to alert employees of potential hazards in the area.
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Planning

Site Pro gives you the ability to enter Planned Jobs
for upcoming planting, tillage, spraying, spreading and
other farming operations.  These Planned Jobs can
be used for Planned Summary Reports that include
the expected amount of product usage (seed, chemi-
cals, fertilizer, etc.) along with planned equipment and
personnel usage.  These reports are ideal for resource
allocation, product ordering, prepaying and budgeting.  Additionally you can edit
or complete planned jobs so actual farming actions do not have to be reentered.

Planned operations are very easy to enter as they follow the same user interface
that is used when entering actual farming actions.  Site Pro has a Planning menu
at the top of the screen that is used for working with planned operations.

Creating Planned Jobs

Planned Jobs will be entered into Site Pro in the same manner as normal farming
actions.  This will involve selecting people, equipment and supplies from the tabs
on the left and then selecting fields on the map.  The following are the steps you will
follow:

1. Select Create Planned Jobs from the Planning menu to go into Plan-
ning Mode.
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2. Select  the Supplies tab on the left and se-
lect the chemicals, seed, fertilizer or other
supplies that you wish to use for the planned
operation.  It is not necessary to use any
supplies in planned jobs.  However, you
should select any items that you wish to in-
clude in your planning reports.  You will se-
lect the items that you want and move them
to the Working Group below.  To select and
move a supply to the Working Group, do
one of the following:

· Double click on the supply item.

· Right-click on the supply and select
Add to Working Group.

· Click on the supply and then click on

the  button in the lower left-hand
corner of the screen.

4. Select the fields that you wish to apply the
plan to.  This can be done by either:

· Clicking on the  button.  After this button is selected

your cursor will change to a Tractor and you can click on the fields that you
wish to enter planned jobs for.  After you have selected all fields you can
click on the Stop Planning button.

Or by

· Holding down the <Shift> or <Ctrl> key on your keyboard and left clicking
on each field that you want to enter planned data for.  This will select the
field and give it a gray cross-hatch pattern.  Once all of the desired fields
have been selected, right-click and select Apply Working Group.
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5. After the Stop Planning button is selected (or Apply Working Group is
selected from the right-click menu), the
Planned Farming box will appear.
This box will list each of the selected
fields in a column along with a Total col-
umn.  The rows of this box will be the
information that you will enter for your
plan.  Information entered in the Total
column will either be split between the
fields based on the size of each field
(for numeric data such as quantities) or
will be copied to each field (for text such
as crops).  The following is a summary
of the data that will be entered:

· Area Farmed  Enter the number of
acres for the planned job for each field.

· Date & Time  Enter the date and the
start and stop time when you plan to
perform the job, if desired.

· Commodity  Enter the crop that you
plan to have in the field.  Site Pro will default to this crop for future opera-
tions.

· Notation Category  Refers to the type of operation being recorded.  For
example, Tillage, Planting, Harvest, etc.

· Note/Instruction  Enter any notes that you wish to include with this plan.
Notes can include descriptions of where certain supplies should be ap-
plied.  An example would be Plant P3388 in the west half of the field.

· Charge Units  Enter the planned number of charge units (hours, tach hours,
acres, etc.,) for any people and equipment to be used in the planned job.

· Supplies  Enter the planned number of acres and the planned application
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rate or total quantity to be used for each supply.  A cost may also be as-
signed to each supply.  The cost will default to the cost that was assigned to
the supply when it was last used (if the supply has never been used it will
default to the cost that was entered when it was set up).

6. When you are finished with a planned job, items can be removed from the
Working group by doing one of the following:

· Double click on the equipment or person in the Working Group.

· Click on the person or equipment in the Working Group then click

on the  button.

· Click on the  button and all items will be removed from the Work-
ing Group.

7. Select Create Planned Jobs from the Planning menu to exit Planning
Mode.

Importing Planned Jobs

Site Pro gives you the ability to import Planned Jobs that are in an FODM format
(with an .fsf file extension).  These can include plans made by seed reps and crop
consultants.  Once imported, these plans will give you the same planned reports
as would be created if you entered planned data using the above steps.  Planned
Jobs can be imported by selecting Import Planned Jobs from the Planning
menu.

Editing and Executing Plans

Once a plan has been completed, you can use Site Pro to document what actually
occurred as a farming action.  Farming actions will be used for creating field histo-
ries, notations, chemical reports and more.
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To complete a planned job:

1. Select Editing & Executing Plans from the
Planning menu.

2. Use the area to the left to restrict the planned
operations to a certain Date Range, Com-
modity, Field, or Landlord.  Once you have
made the desired selection, click on the Up-
date List button so only the appropriate plans
will be displayed.

3. Select the planned operation(s) on the right
by clicking on the operations.  Alternately the Select All button can be used
to select all displayed operations.

4. Select the Complete button to complete the selected operations.  After this
is done the Farming box will come up with the planned information dis-
played.  Make any changes that are needed to reflect what was actually
done.  Completed Farming Actions will be included in Notations, Chemical,
Fertilizer, Seed and other reports.

5.  Select Done to close the window.

Planned jobs may be edited, printed, deleted or exported from this screen as well.
Simply complete steps 1-3 as discussed previously and follow the appropriate
steps below.

Edit

Editing a planned job will allow you to edit existing
information within a planned job.  Applied quantities
of supplies as well as charge units for people and
equipment may be edited.

To edit a planned job, highlight the desired job(s) and
select the Edit button.
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Print

Printing a planned job will give you an Operation Worksheet.  This worksheet will
be useful to send to the fields with workers, as it includes a picture of the field as
well as the information that was entered in the planned job.  Additionally, this re-
port, when printed, will allow record keeping of weather and field conditions.

To print an Operation Worksheet for a planned job, highlight the desired job(s) and
select the Print button.

Delete

Deleting a planned job removed all information associated with a planned job.

To delete a planned job, highlight the unwanted job(s) and select the Delete
button.

Export

Exporting a planned job will allow the job to be synchronized to Trac Mate as a
work order.  If synchronizing with more than one hand held, a planned job will
have to be exported prior to synchronization with each hand held.

To export a planned job, highlight the desired job(s) and select the Export button.

Exported jobs will be marked as Pending and will remain in the Editing &
Executing screen until the completed job has been synchronized from Trac Mate
or the job has been completed on the desktop.
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Printing Planned Summary Reports

Select Summary Reports from the Planning menu to display planned reports.
Planned summary reports can be sorted according to  a date range and can in-
clude complete or incomplete plans.  Planned reports can be used for resource
allocation, budgeting, planning, product ordering, prepaying and other functions.
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Overview
The information stored in Site Pro can be compiled and shared with your clients
through its many reports.  These reports will provide a historical account of the
actions taken and practices used in the production of your clients' crops.  This
record will assist you in determining what has and has not worked in the past.  The
successes of the past can then be repeated, and lessons can be learned from
past failures.  With the advent of site specific technologies such as yield monitors
and global positioning receivers, the effect of these actions can be measured and
put into terms that every producer understands: their bottom line.  In addition to
providing insight into past practices, these reports will help you and your clients
comply with the growing regulations on pesticide applications.

Field Activity
Each time a product is applied to a field, several records are generated.  The first
of these records is used to generate the Field Activity report.  This report lists the
date of application along with the product’s rate and cost.  This report can serve as
the basis for estimating the direct costs of production.  To print this report, select
Field Activity Report from the History menu, then select the fields to include.

Crop Summary
The Crop Summary Report will allow you to view data by field, landlord, crop,
year and/or county.  To view or print this report, select it from the History menu.

History and Reports
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Yield Monitor Load
The Yield Monitor Load Report will allow you to view yield data for each client.
To view or print this report, select it from the History menu.You may print a load
report for any field(s) to display a summary of:  the Layer and Field name, Load ID,
number of Samples (or points), average Moisture, Area covered, Average Yield
and Total Yield.  Some data (such as Ag Leader basic format) will not have load
IDs and will only give a summary for the field.

Notations
Notations are used to tell a story about the history of a field.  These notes contain
product applications along with scouting reports, comments about practices, and
weather observations.  These notations may be categorized and filtered to give a
brief summary about a single aspect of production.  For example, the list of nota-
tions may be filtered to show just those that involved the application of Atrazine.
This information would be useful in determining the type of crop to produce in this
field the following year.

Notations may be viewed by right-clicking on the desired field and selecting Nota-
tions from the menu.  A report for more than one field may be printed by selecting
Notations · Report from the History menu.

Editing Notation Histories

Notes may be added to a specific field by right-clicking on the field and choosing
Notations from the menu.  The notes that are listed may be edited, deleted, or
added to.  Those notations created by applying products should only be deleted by
removing the operation though the Remove Product Application option on the
History menu.  Editing an application notation will have no effect on the field activ-
ity report or the chemical application records.

Notes may be categorized to allow each type of notation to be filtered and ac-
cessed more easily.  For example, you may have a category for scouting reports,
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and another for notes about the weather.  Application notes may also be queried to
show just those involving a particular chemical.  To activate such a filter, press the
Show Me button, and select the categories and supplies to be included in the list
of notes.

A notation may be added to several fields at one time by selecting the fields, right-
clicking, and choosing Add Multiple Notations.  A special type of notation may
also be created that applies to all of a client’s fields.  This type of notation can be
created by selecting Notations · General from the History menu.  Since a Gen-
eral notation applies to all fields, any change to this type of notation is reflected on
all fields.

Chemical Application Reports
Site Pro can help you and your clients  meet EPA regulations that require records
to be kept for applications of restricted use pesticides.  Application records are
generated each time a product is applied to a field.  Only those supplies that are
marked as Keep Chemical Records will generate the information that is needed
for EPA compliance. These records may then be sorted and filtered by date, field,
crop, or chemical applied.  To generate a report, select Chemicals · Report from
the History menu.

The chemical report may be printed in two different formats:  The Line Format
lists the basic information regarding each operation.  The information on this re-
port includes the application date, location, applicator, and product details. The
Page Format lists all the details about the operation, including field and weather
conditions, in addition to the information included on the Line Format.  The RUP
Only option allow you to print only Restricted Use Pesticides.  This report may be
printed in either format.

Restricted Entry Schedules
Future applications of pesticides may also be scheduled in order to protect work-
ers who may need to be warned before entering the treated area. The procedure
for scheduling an application is covered in the Creating Restricted Entry Sched-
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ules section of this manual and in the help files.

The schedule of restricted entry applications may be printed by selecting Restricted
Entry · Report from the History menu.  The information on the report is custom-
ized for three different levels of notification.

• Pesticide Application List:  use this form to notify anyone working in or near
the area of scheduled treatments.

• Owners & Operators:  provide this form to custom applicators or independent
crop advisors that you hire who should be warned of any scheduled treatments.

• Custom Applicators:  provide this form to your clients so that they are
warned of scheduled treatments that may prevent re-entry into the affected
fields.

These reports conform to the 1992 Federal Worker Protection Standards.

Operations Maintenance
The Operations Maintenance report is available by right clicking on a field and
selecting Operation Maintenance.  This report will break down the farming op-
eration by region and will show a total cost of supplies per region as well as an
operation grand total.  Any field and weather information that was recorded for the
operation will be included in this report as well.    Operations may be sorted by
Start Date, End Date, Commodity, Type, Field or Landlord by  using the filter at the
left of this screen.

Farming operations may also be deleted from this screen as well.  To Delete a
farming operation, highlight the unwanted operation and select Delete.  This will
remove the entire farming operation.

Farming operations may also be merged within this screen.  To Merge multiple
farming operations, highlight the desired operations by holding down <Ctrl> and
left clicking on each operation to be merged.  Once highlighted, select the Merge
button.  The selected operations will become one.  The merged operations will
now show on a single report, each as a different region.
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The View Map button within this screen will allow you to view a map of an opera-
tion completed in Trac Mate.  Simply highlight the desired operation and select the
View Map button.  This will cause the map created by the Trac Mate/Site Mate job
to become the active layer.
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